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TSM Conference 2003 

Graeme Brown  -  Excel@Mathematics 
_______________________________________________________________________  
 
Key Problem Solving Techniques: 
  
A small collection of simple techniques can, with a little imagination, open up large areas 
of mathematics in interesting ways. 
 
Useful Excel techniques include: 
 

• Absolute cell references – the normal state for the cell references in a formula is 
to be a relative reference. This means that when that formula is copied to a new 
position it builds a new formula with the cells references that relate to the new 
position rather than returning to the cell references used in the original formula. For 
example: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• The INT function drops the fraction part of a number and just returns the integer 
part.  INT(4.1623) would return 4 , INT(4.8623) would also return 4. INT has many 
uses, but the two covered in this workshop are  

o Getting at the individual digits in a number.  
(see technique note: Getting at Digits using the INT function) 

o Creating random numbers in a given range. 

Remember in Excel = is needed at the start of a formula to be calculated, otherwise 
Excel assumes that INT is just a word you wanted to type. 

• The ABS function returns the absolute value: ABS(20 – 50) would return 30 not  – 
30.  

This is the formula for the cell B4. 
It adds together the two cell values 
immediately above. 

If B4 is copied to D4, D4 will receive the formula 
=D2+D3 . This automatically contains the correct cell 
references to replicate the effect that B2+B3 had in B4. 
 
If B4 had instead contained the formula $B$2+$B$3, 
the result for B4 would remain the same but when 
copied to D4 the references would not adjust 
automatically. D4 would get exactly the same formula 
as B4 not its own formula to achieve the same effect. 
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• The MOD function returns the remainder when one value is divided by another. 
MOD(15,2) would return 1 , MOD(15,3) would return 0. 
 
The MOD (modulo) function is particularly valuable when exploring factors, multiples, and 
remainders. 

• Conditional Formatting – Excel has the ability to change the appearance of individual 
cells based on the cell’s contents at that time. (see technique note: Conditional Formatting) 

Conditional Formatting is particularly powerful if values of interest are hard to identify, just 
by inspection. The Beads investigation introduced in the first session is a good example. 
Conditional formatting was set to ensure that remainders of 1 were conspicuous. 

• Working with two independent variables  
(see note: To produce a table of values for a function of two independent variables) 
 

The Pythagorean Triples investigation makes interesting use of this technique in 
conjunction with conditional formatting. 

• Generating random numbers 
The command :   =RAND()  will produce a random value between 0 and 1. 

So  =10*RAND()   will produce a random value between 0 and 10 

and =INT(10*RAND())   will produce a random integer between 0 and 9 

=1+INT(10*RAND())    will produce a random integer between 1 and 10 

 

It is possible, and worth a try, that your school PC has the RANDBETWEEN function 

installed. This is not set up as the default installation of Excel. 

=RANDBETWEEN(10,30)  would produce a random integer in the 10 to 30 range.  

The Help index in Excel will give guidance about extras functions which can be installed. 
 

It is also a useful problem solving task for pupils, just once, to generate the required random value 

range using only the basic functions as building blocks.  

__________________________________________________  

Note: NRICH web site 

The following web page has a large number of working Excel files demonstrating and 

extending these notes on paper:  

http://nrich.maths.org/mathsf/journalf/rb_excel_archive.html  

A new Excel@Mathematics item appears each month on the NRICH site (under features). 
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Beads:  

When an unspecified quantity of beads is divided into two equal piles one bead is left over.  
When the same heap is divided into three, four, five, or six, equal piles, that remainder of 
one persists. With this information can you say how many beads there were?  
Is a solution even possible? Is there more than one solution? Was the result predictable? 
 
Extend the enquiry by investigating other remainders, other divisors, or even other rules 
for distribution. 
 
Approaching a solution (off-screen planning is essential), one layout could be: 
 
Column one: the number of beads. The first row has one, the next two, and so on.  
Column two: the remainder after a division by two  
Column three: the remainder after a division by three  
Until all the required calculations are displaying their results .  
Solutions occur wherever a row contains all ones. 
Conditional formatting has been applied to automatically highlight cells that hold a value of 
1, but this is not necessary. 
 
It is now immediately apparent that one solution is to have 61 beads, while scrolling down 
further reveals more solutions at 121, 181 and so on at intervals of 60. 
Spared the tedious individual calculation we are free to ask: "why intervals of 60"?  
 
We might look for a relationship between this interval of 60 and the divisors, 2, 3, 4, 5, 6, 
and notice that 60 is the lowest common multiple of all these divisors.  
Is the lowest common multiple relevant to the problem? 
 
 
This demonstration compresses the problem solving process from a couple of hours to a 
few minutes. The problem is the focus, not the spreadsheet, which has merely produced 
helpful numerical results. The mathematics happened when we were trying to understand 
the problem, trying out some numbers manually, thinking how a spreadsheet might be 
useful, planning what was needed and how to organise the calculations in columns, 
interpreting the results, making connections, trying to justify our insights to ourselves and 
to others. 
 
Investigation techniques applied to two examples More Beads and Ring on a String 
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More Beads 
A heap of beads was shared out between three people by a professional bead sharer. The 
first person got one third, but not before the bead sharer had taken one bead as 
commission. The second person had one third of what remained but again, after 
commission of one bead had been taken by the bead sharer. The third person also 
received a one third portion of what remains but, as before, after a one bead commission 
had been taken.  
Once all three people had received beads the bead sharer took a final commission of one 
bead and shared the remaining beads equally between the three people. There were no 
beads left over and beads were not split into fractions. How many beads were there at the 
start? 
 
As always, start by trying out some numbers to get a feel for the procedure you will be 
investigating. Next plan out on paper what calculation each of the columns will contain and 
also what range of numbers you will use initially. 
It helps to have several columns taking the procedure in small steps rather than trying to 
leap to the answer in one complex calculation. 
 
Here’s a possible plan: 

Column 1 – Number of beads. Maybe start at 1 and perhaps run down to around 200 initially. 
Column 2 – The number of beads after the bead sharer’s first commission of 1 bead 
Column 3 – One third of the beads 
Column 4 – The remainder when this third is removed 
Column 5 – The beads after the second commission of 1 bead 
Column 6 – One third of the beads at this point 
Column 7 – The remainder when this third is removed 
Column 8 – The beads after the third commission of 1 bead 
Column 9 - One third of the beads at this point  
Column 10 - The remainder when this third is removed 
Column 11 – The beads after the final 1 bead commission 
Column 12  - The final division into three equal amounts. 

 
If the numbers right through to the end of the row remain integer, then the start number of 
beads was a solution to the problem. 
The row gets quite long. Trying to look at both the beginning and the end is frustrating. It 
can be helpful to create a new row at or near the beginning and make this show (repeat) 
the value at the end. 
 
Good investigation practice, with or without a spreadsheet. 
Interesting results often come from procedures that are too complex to be obvious. 
We need to teach pupils to strip back to the simplest version of the procedure, and 
develop forward to the actual context in small steps. 
 
So in this investigation that would mean just two people and no professional bead sharer 
taking a commission. Then three people. Perhaps four people if a pattern is emerging. 
Then look at the effect when the commission payment operates. 
 
A key investigation skill : working backwards 
The whole procedure could be represented on the spreadsheet in reverse. 
Starting with the quantity in the final share round. Successive columns would show the 
number of beads prior to that stage until the final column which would show the number of 
beads required at the start. 
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Ring on a String  (see the pupil worksheet - Ring on a String) 
 
 
Some start value choices have to be made, then remade as the investigation develops. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If AB was 100, AD 30 and BC 50. There is now only one variable, the position of R along 
AB. 
If the first column is the distance of R from A starting at 1 and increasing by 1 until 100 is 
reached. 
The distance DR is the hypotenuse of a known right-angled triangle, and can be calculated 
with Pythagoras’ Theorem. Similarly for CR. The ring will settle wherever the total DRC is 
least. So the final column is the sum of the lengths DR and CR. Casting an eye down this 
column for the minimum value is all that is required to bet a good first result. (An 
approximate result because the possible positions of R were taken at intervals of 1) 
Next the position of D or C can be altered in a systematic way until sufficient results are 
produced for any pattern to become clear. Then the key question: “Why that pattern?” 
 
The INT function allows digits within a number to be isolated. Many investigation tasks rest 
on a property of the digits. The technique help sheet: Getting at Digits – Using the INT 
function , explains what to do and suggests an investigation task called Casting Out Nines 
which is based on the Digit Sum. 
 
The next two investigations, Pythagorean Triples and The Sum of Consecutive Numbers, 
use Excel to support group discussion. The Excel display provides instant interactive 
response as pupils form and test out their ideas, but at Key Stage 3 only very able pupils 
will want to explore the construction method. 
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Pythagorean Triples  
 
Find sets of three numbers so that the sum of the squares of the first two is equal to the 
square of the third, as in  (3, 4, 5) or (5, 12, 13).  
Using the Excel technique for problems with two independent variables create a table of all 
possible first and second number combinations to see which of these provide integer 
results for the square root of the sum of their squares. 
 
The formula for the first cell is =SQRT(B$1^2+$A2^2) which is then copied across the 
chosen range. Then look for cells in which this formula returns integer values. Conditional 
formatting helps identify the values of interest. The colour change occurs when a cell value 
is exactly equal to its integer part. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The red type on a tan background are genuine integers, and are the result of the 
conditional formatting being activated. The other integers in the sheet are caused by Excel 
rounding the display value to 2 digits even though the held value may have many decimal 
places, as increasing the width of a column would reveal. 
With a Zoom view of 10% some patterns become obvious. Pupils should be encouraged to 
account for the patterns they observe. (reflection in the diagonal and enlargement or 
similar triangles are the most obvious patterns) 
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The Sum of Consecutive Numbers 
 
The pupil sheets The Sum of Consecutive Numbers cover the main activity. Excel is used 
here, as a ready made file, to provides an excellent interactive presentation to support 
class discussion as pupils form and test their own ideas. 
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Conditional Formatting Notes 
 
See the web page: www.nrich.maths.org/mathsf/journalf/jul03/excel.html  
On the Excel File called “Conditional Formatting Demonstration”, sliders control C2 and 
C9, spinners control C13 and C14. 
 
Conditional Formatting is a setting applied to a cell which causes the appearance of the 
cell to change if a specified condition occurs. 
 
There are two basic types of conditional formatting. One where the condition involves the 
value in that cell, the other where the condition is based on values from other cells around 
the sheet.  The demonstration Excel file gives an example of each. 
 
If C2 's value goes into the 50 - 60 range you’ll see the cell’s formatting change. 
 
Click on C2, then choose Conditional Formatting on the Format menu to see the settings 
used. 
 
 
 
 
 
 
 
 
 
 
Clicking the “ Format . . . ”  button allows different colours to be selected. 
 
The next slider controls C9.  
 
C9 also has Conditional Formatting applied, but this time the condition is not dependent on 
C9 's own value. 
C9 can be made to change its appearance based on values elsewhere in the sheet.  
In this case, the values in C13 and C14. C9 's own value has no influence. 
Here’s the setting: 
 
 
 
 
 
 
 
 
 
 
Notice that the first field in the dialogue box is set to “ Formula Is ”, and that, in the second 
field, the condition has to start with an “ = ” sign.  
Excel needs the “ = ” to know that what follows is a formula, to calculate or test. 
 
So, with this setting, if  C13 > C14  the alternative formatting for C9 is triggered.  
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Inserting an Increment Button (Spinner) or Scroll Bar 
to control the values in a cell 

 
• The cell values are usually entered on the keyboard, but sometimes it is desirable 

to keep attention completely on the spreadsheet and not to use the keyboard at all 
for entering or changing cell values, e.g. with an interactive whiteboard. This can be 
achieved using increment buttons. There are two types available, Excel calls them 
Spinners and Scroll Bars.  

• The Spinner is a two part button made formed from an up arrow and a down arrow. 
The control is set on the Spinner so that the values stay within a chosen range and 
only change in steps of a specified size. The scroll bar is the same but with a slider 
between the two arrows. 

• Spinners and Scroll bars are found on the Forms toolbar. 
To turn on any toolbar go to the View menu, choose toolbar 
and select the toolbars you wish to have on view. If you 
drag a toolbar to the top or bottom of the workspace it will 
become absorbed amongst the toolbar buttons already 
there. 

 
 
 

• Chose the tool (spinner or scroll bar) from the 
toolbar, then just click and drag out the rectangular 
outline for the button you wish to create. It can be 
any size. Note: the size and other characteristics can 
be changed at any time. 

 
• After you have a button on the workspace the next task is to connect it to a cell.            

Right-click on the button, choose Format Control, and complete the dialogue box. 

To insert a 
Scroll Bar 

To insert a 
Spinner 

Check you have 
the Control tab. 

Set the range, by using 
the Min. and Max values. 

Set the step size. This 
must be an integer. 

Set the cell reference to determine 
which cell this button will control. 



 
This file is available from the Association of Teachers of Mathematics web site: www.atm.org.uk 

 
graemebrownuk@hotmail.com 

10 

To produce a table of values for: 
A function of two independent variables 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The cell C3 contains the formula:   = C$2 * $B3   
 
* means multiply, C2 is the factor from the top row and B3 is the factor from 
the left hand column. The dollar sign, $, ensures that when the formula is 
copied from C3 across the whole C3:E5 range the first factor will continue to 
be taken from row 2 and the second factor will still be taken from column B. 
 
The keystrokes for the copy manoeuvre are:  

• select C3 (just click on it) 
• choose Copy from the Edit menu 
• highlight (click and drag) the C3:E5 range 
• choose Paste from the Edit menu 

 
The formula from C3 is copied automatically to all cells in the C3:E5 range. 
The formula is adjusted  for each new position except where a $ sign was 
placed to show that this automatic assistance is unwanted. 
 


